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1 INTRODUCTION

1.1 Need for this manual

Water, sanitation, and hygiene (WASH) services are critical for reducing morbidity and mortality
during the humanitarian emergencies in refugee settings. The ability to monitor and assess these
services during emergencies is essential. Household-based Knowledge Attitudes and Practices (KAP)
surveys are used by UNHCR and its partners to inform WASH program design. While this method
provides precise (+ 5%) estimates of WASH core indicators, it requires a sample size of 360
households (HH) and takes several days to complete with a team of trained surveyors to complete.
During acute stages of emergencies, when there is limited time and resources available to collect data
and little or no information about the number of households in a camp, there is a need for a rapid
assessment method. The random location cluster (RLC) sampling approach presented in this manual is
a method that can be used for rapid assessments of WASH services in camps during the early stages
of an emergency.

This manual originated from a demand for a sampling approach that could be completed with four
to six trained interviewers in a day. Research studies previously commissioned by UNHCR used Monte
Carlo simulations to demonstrate that a 60 HH sample size was adequate for rapid assessments of
core WASH indicators, even with sampling designs with 20 clusters of 3 households. This research
proposed that clusters of households could be selected using random GPS coordinates. However, it
was noted that this approach can introduce a bias due to spatial variations in the level of services. For
example, households with better access to services may be clustered in the camp center and those
lower access to services may be available on the outskirts. To compensate for this bias, it was
proposed to use weighting factors based on the estimated population density at each cluster. In 2017,
the RLC sampling method was pilot-tested by UNHCR, CDC, and the REACH Initiative at 19 different
camp zones in emerging settlements in Bangladesh, Syria, and Irag. Following this successful pilot
study, UNHCR and REACH decided to deploy the use of the RLC sampling method internally for one
year to obtain broader feedback. The purpose of this briefing note is to provide guidance on the
implementation of this sampling method.

1.2 Target audience

The target audience for this manual includes UNHCR WASH partners involved in camp-based
humanitarian WASH response efforts. This manual is intended for these user groups. This manual can
be used to prepare for and implement RLC surveys for the rapid assessment of WASH services during
emergencies. The manual can also be used for capacity building activities with relevant staff.

1.3 How to use this manual

This manual provides an overview of the RLC sampling approach, including the methodologies for
mobile data collection, design effect estimates, and the adjustment for the household density bias. The
steps of preparing and completing a survey using the RLC method are described. As such, this manual
provides a general guideline. The survey design should be adapted to the context in which you work.
Additional tools to complement this manual are available on http://wash.unhcr.org/.
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2 OVERVIEW OF RLC WASH SURVEYS

2.1 What is an RLC sample?

An RLC sample stands for Random Location Cluster sample. In this method, households are
identified based on randomly generated GPS coordinates within the populated physical boundaries of
the camp or zone. To save time, three households closest to each of 20 randomly-generated
coordinates are surveyed, forming 20 “clusters” of 3 households.
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Figure 1. Overview of the RLC sampling method
2.2 Objectives of a rapid assessment

The objectives of a WASH rapid assessment are to obtain a brief snapshot of WASH services at the
household level, determine problematic areas for immediate attention, and track progress and
compliance with UNHCR WASH standards. The survey is purposefully brief, including only questions
related to six core WASH indicators and UNHCR standards for emergencies (Table 1). This brevity
reduces the time required to complete the survey by collecting only the most important information.
The suggested questions for the RLC survey are provided in Table 2. Additional questions can be
included as appropriate, however additional indicators have not been piloted, and the errors
associated with RLC sample estimates for other indicators may be different than the errors presented
herein.

Table 1. Core indicators for the RLC survey and UNHCR standards during emergencies

No. Indicator UNHCR Standard for
Emergency Situations
1 Average liters per day of potable water collected per person at the household level >15 L/p/d
2 Percent of households with at least 10 liters/person potable water storage capacity >70%
3 Percent of households collecting drinking water from protected/treated sources >70%
4 Percent of households reporting defecating in a toilet >60%
5 Percent of households with access to soap >70%
6 Percent of households with a designated bathing facility >70%

Many camps/settlements have populations between 5,000 and 150,000 people, with a total of
1,000 to 30,000 households, although this can vary widely for each situation. Camps are often
subdivided into several different administrative zones, and in some situations, it is necessary to
estimate differences in the level of WASH services for each zone within a camp, in order to target
corrective actions for zones with the lowest levels of service. It is important to note that you must
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collect 60 HH samples from each zone for which you want to have independent estimates (to make
independent decisions to take action).

3 PREPARING FOR THE SURVEY

During an emergency, the resources needed to complete a KAP survey might be better spent
addressing immediate needs of the emergency. The RLC sampling method saves time by sampling
only 60 HH, but does so at the expense of precision. The KAP survey method (with the recommended
360 HH sample size) gives a margin of error of 5% (with 95% confidence). The margin of error of the
RLC method at the same confidence level ranges from £13% at best to +22% at worst (see Box 1).

3.1 Deciding if RLC sampling should be used

Different sampling approaches are appropriate for different situations. In a post-emergency setting,
the standard KAP survey method should be followed. During emergencies, systematic “skip interval”
sampling is preferable over RLC sampling, but is only possible if the total number of households is
known and if households are situated in a clear pattern (e.g. rows), which is common in planned
camps. If the situation of households presents challenges for systematic sampling, RLC sampling
should be used. The decision tree in Figure 1 can help determine the most appropriate sampling
approach.

What is the current status in
the camp or settlement?

. B N N B N B B _§ | '

I KAP SurveyI

Emergency : Post-Emergency :

Do you know the total l KAP Survey I
number of households or the l Use systematic sampling with I
total population (within + 5%) l the recommended 360 HH I
in the camp/settlement? sample size, as described in I

: the KAP survey guidelines. -.

| Mo J—— ves | —_————————

Are households situated in a clear pattern
(e.g. rows), allowing enumerators to walk
past all households in a systematic way?

No | Yes

|
--------I--------I‘
I Random Location i Systematic Skip
:Cluster Sampling | Interval Sampling
|
l Random Location Cluster (RLC) Sampling l Systematic Sampling
l Sample 20 clusters of 3 HHs (for a total of l Use systematic sampling with a skip interval
l 60 HHs in the camp) by choosing random equal to the total number of households
coordinates within the populated area of [«— l divided by 60 (rounded down to the nearest
l the camp or zone. The data must be l number), and proceed with the sample until
l adjusted for differences in the population l you pass by all households in the camp (even if
l density at different locations in the camp. l the sample size ends up being more than 60).
l----------------‘

Figure 2. Decision tree to decide when to use the RLC sampling method
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BOX 1. MARGIN OF ERROR OF SAMPLE ESTIMATES
What does it mean to have a margin of error of £18% at 95% confidence?

A margin of error of £18% means that if your RLC survey data indicate that 50% of households from
a camp have access to a toilet, the true underlying percentage of households in the entire camp with
access to a toilet may be as low as 32% or as high as 68%. The term 95% confidence means that on
average, 95 out of 100 times a survey is completed, the true underlying percentage of households in
the entire camp will lie somewhere between the upper and lower limits (i.e., 32% — 68% for example
above).

The margins of error for the RLC sampling method differ from question to question, ranging from
+13% and £22%. The reason for this difference in precision is that the use of clusters introduces what’s
known as a design effect, which is a measure of how similar households within a cluster are to each
other, compared to households in other clusters. A design effect of 1.0 means that cluster sampling
provides the same precision as simple random sampling. A design effect of 2.0 means that the cluster
sample requires twice as many households as a simple random sample to provide the same level of
precision. A design effect of 3.0 means that the cluster sample requires three times as many
households as a simple random sample to provide the same level of precision. Design effects can be
different for each question asked. Pilot testing of the RLC method with 20 clusters of 3 households
indicated that the design effects are around 1.5 for some questions and as high as 2.5 for others. The
design effect should be estimated each time an RLC sample is collected. More information about the
design effects and how they can be estimated is provided in the report from the RLC Pilot Project,
available at wash.unhcr.org.

3.2 Defining the boundaries of the populated area

Before starting the RLC survey, it is important to make a quick reconnaissance of the site to define
the physical boundaries of the populated area of the camp. The recommended tool to use for defining
the boundaries of the populated area of the camp is Geographical Information Systems (GIS) software.
A variety of open source GIS software is available for free download and use, for example: QGIS
(ggis.org), GRASS GIS (grass.osgeo.org), and gvSIG (gvsig.com). If recent satellite imagery is available
and georeferenced, then the satellite images can be used in a GIS software to define the boundary of
the populated area remotely. However, it should be noted that in many emergency situations, the
population dynamics change so rapidly that satellite images taken several weeks prior to the planned
date of an RLC survey may be no longer accurate. It is best to drive or walk the boundary of the
populated area one day prior to the implementation of the RLC survey, recording the coordinates of
points along the boundary using a GPS unit (some GPS units also allow users to record paths or lines
instead of points). GPS points along the populated area boundary can be uploaded into GIS software
to draw a polygon around the populated area.

3.3 Generating random waypoints

Most GIS software will have some sort of tool that allows for the generation of random points
(waypoints) within a polygon based on the selection of random coordinates. For example, QGIS has the
“random points inside polygons” feature. The Annex of this briefing note has an explanation of how to
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generate random waypoints in QGIS. In addition, tutorials can be found online.' The RLC sampling
method requires 60 HH to be selected in cluster sizes of three, meaning that 20 random waypoints are
needed. However, if the waypoints have to be generated a day or two in advance (for example, if
internet is needed to generate the waypoints, but there is no internet at the camp), it is advantageous
to generate several “extra” waypoints at the beginning, in case one or more of the waypoints ends up
being in unfavorable locations, such as in the middle of a pond or an agricultural field, or in some other
non-populated area that can be removed from the populated area boundaries post hoc (see Figure 2).

Figure 2. Polygon of the outer boundaries of a camp (solid red lines) with 20 random waypoints
generated (blue filled circles); Also shown are two points (red X marks) that can be eliminated from
the list of waypoints because they fall within uninhabited areas of the camp (new boundaries of the
populated area are delineated with dashed red lines).

3.4 Developing the questionnaire

For the most part, the questionnaire for rapid assessment surveys will be relatively consistent from
site to site, with the same general questions included in each survey. However, the wording of the
questions may change depending on the implementing organization’s perception of the most
appropriate way to ask each question, given the geographical and cultural context of the site or the
language that the survey is conducted in. Table 2 includes a list of the core set of questions, with some
common variations of each question. Survey questions can be modified based on your setting in case
the questions at disposition are not appropriate for your survey. Modifications can include changing
the phrasing of an existing question to better fit the context/objective, adding a completely new
question, or modifying, adding, or deleting answer choices based on the setting. Refugee settings
around the world differ much from one to another in terms of WASH services or cultural practices and
habits. For example, types of latrines might be different in Asia and in Africa; in some camps water

! See http://youtu.be/A-nloh5{YvY or search for “Random Points Inside Polygon” on Youtube or other online video
references
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might be stored in large household tanks whereas in most camps the population uses in-house

recipients. To make the questionnaire as light as possible, it is recommended to remove all answer

options that are not relevant in the context of the planned survey. It is also important to try to keep

changes to a minimum so as to maintain comparability over time and across different sites.

Table 2. Core set of questions for the RLC WASH survey, grouped by indicator

Questions

\ General preliminary questions
What is the name of the camp or zone
being assessed?

Variations (alternative
phrasings for questions)

Instructions for XLS Programmers and
Surveyors

Enter the waypoint number used to
identify this household. Re-enter the
waypoint number.

XLS Programmer: Use unique three-digit
numbers for each waypoint.

Enter the household number.

XLS Programmer: Number the households 1,
2, 3, etc. If one (or more) of the first three
households must be skipped due to non-
response or other reasons, the replacement
household(s) should use a unique number
(starting with 4, 5, etc.)

Record the household’s GPS coordinates

How many people live and slept in this
house last night?
| Introduction and Consent Statement

Hello, | am on a team that is working with UNHCR. We are doing an assessment on water, sanitaiton, and hygiene in this
camp. The survey usually takes 10 minutes to complete. Any information that you provide will be kept anonymous. This is
voluntary and you can choose not to answer any or all of the questions if you want; you may also choose to quit at any point.
However, we hope that you will participate since your views are important. Participation in the survey does not have any
impact on whether you or your family receive assistance. Do you have any questions? May | begin now?

1. Average number of liters per day of potable water collected per person at the household level
2. Percent of households with at least 10 liters/person potable water storage capacity

3. Percent of households collecting drinki
What is the principal source of drinking
water for members of your household? If
other, please specify.

What is the total volume of containers or
tanks you have to COLLECT and STORE
drinking water for your house? Could you
show me all of them one by one?

What is the total number of journeys
made with containers for the collecting of
DRINKING water YESTERDAY?

Variation (replaces a/b/c): How
many containers do you have to
COLLECT and STORE drinking
water for your house? Could
you show me them one-by-one?
REPEAT: What is the type of
container? What is the volume
of the container? Is the
container protected? Number of
journeys made with the
container for the collection of
water YESTERDAY.

ng water from protected or treated sources*

Surveyor: Add the cumulative volume of all
protected containers and all unprotected
containers. The following are considered
protected or treated sources: public
taps/standpipes, handpumps/boreholes, piped
connections, protected springs, water
sellers/kiosks, tanker trucks, bottled
water/sachets. The following are not
considered protected or treated: unprotected
wells, surface water (lake, pond, and river),
unprotected springs, rainwater collection.

Calculate the total volume of drinking
water collected.

Surveyor: Add up the cumulative volume of
drinking water collected based on the volume
of the containers and the number of journeys
made with each container during a day.

Do you treat your water before drinking it
now? How do you usually treat your
drinking water now?

Variation: Did you treat your
water today before drinking it?
How did you treat it?

\ 4. Percent of households reporting defecating in a toilet

10
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Questions Variations (alternative ‘ Instructions for XLS Programmers and

phrasings for questions)
Where do you and your household Variation: Where do you and
members usually go to defecate? if your household members
other, please specify. usually go to the toilet? If other,
please specify.

\ 5. Percent of households with soap for handwashing

Surveyors

Could you please show me the soap or Surveyor: Was it presented within one

other rubbing agent you have in the minute?

household?

Please show me the facility where you Surveyor: Do they have a designated bathing
and your family members bathe. facility?

\ General questions for the estimation of the household density correction factor
Can the horizontal distance between the

waypoint and the third nearest
household be measured easily?

If yes: What is the horizontal distance in Surveyor: If the distance is longer than 100 m,
meters between the third nearest do not measure it, enter 999 or see if there is
household and the cluster GPS waypoint a portion of the camp that can be eliminated
used to identify this household? from the inhabited area (see Figure 2). How

was this distance measured? (GPS, digital
meter, tape measure, approximated visually)

If no: Record the GPS coordinates of the
waypoint and the third nearest
household.

The use of mobile devices to collect survey information is highly encouraged. To facilitate the task
of partner organizations, both in deploying the WASH KAP and in data collection, we have set up a
mobile version of the form compatible with related analysis tools. A preview of this form can be found
on UNHCR’s website: http://wash.unhcr.org/. Using mobile devices to implement the survey has many
advantages, such as increasing data quality, increasing the speed of data collection and analysis,
avoiding double entry of data and associated loss of time, capturing GPS points or photos using the
same tool, managing multi-lingual environments more easily, integrating data collection with pre-
programmed data analysis scripts, and many more. Mobile devices should not be used if the security
situation is uncertain and bringing smartphones or tablets could be risky for the surveyors, or if the
time required to buy the phones, set up the system, etc. will not outweigh the time saved on data
entry.

3.5 Pre-testing and training survey team members

Prior to implementation, the survey must be pre-tested during a pilot test. This will help the survey
team familiarize themselves with the questionnaire and check the appropriateness of the questions.
This pre-test is especially important if mobile data collection devices are used, as it is the last
opportunity to evaluate the content of the survey before deployment. It is crucial to run the pre-testin a
situation that is as close to the real one as possible (ideally done with refugees of the same camp that
are not in the sampling). It will also be a good way to test the surveyors’ standard operating
procedures to check the surveyors’ behaviors (proper introductions, consent demand, explanations,
and required observations) to avoid any bad habits that may be harder to notice and change after
deployment. The pilot debrief session is essential for all to get off to a good start.

Before conducting the survey, the surveyors need to be trained on the purpose and objectives of
the RLC survey, the roles and responsibilities of the surveyors, the rationale for each question, the use
of mobile data collection devices (if applicable), the selection of households (using the random GPS
locations), interviewing techniques and common errors (e.g. do not read out instructions, just the

11
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question exactly as it is formulated). Surveyors should also review each question of the questionnaire
to see whether they are clear or if they need to be reworded. They should review the use of the GPS
unit to find the waypoints generated randomly, and they should feel comfortable measuring the
distance in meters between the waypoint and the third nearest household.

4 \MPLEMENTING THE RLC METHOD

4.1 Finding the waypoints

Enter each pair of coordinates, one at a time, as waypoints into the phone or GPS unit. If you sort
the points first by latitude, then by longitude, it will make it easier to walk to them in order {without
having to cross-cross the camp several times). Or you can use navigation applications on the mobile
device to navegate to the waypoints. Various free aplications can be used for ofline navegation (e.g.
Avenza).

Once you enter a waypoint, navigate until you arrive at the specified point. Suppose the waypoints
are labeled 101 — 120. When you arrive at waypoint 101, find and survey the nearest three households.
Then, measure the distance between waypoint 101 and the third-nearest household to that waypoint.

BOX 2. RULES FOR MEASURING THE DISTANCE TO THE THIRD NEAREST HOUSEHOLD
1. Measure from the waypoint to the nearest edge of the closest household or shelter.

2. If there is some physical barrier preventing the measurement of this distance (another
household or a wall), estimate the distance using another means, and make a note of the
method used.

3. If the distance to the third nearest household appears to be longer than 100 m, do not
measure it. See if there is a portion of the camp that can be eliminated from the area of
interest (the inhabited area). If this area cannot be eliminated, then enter 999 m as the
distance and continue with the survey.

4.2 Conducting the surveys

The survey manager will distribute the list of random GPS coordinates to the team(s) of surveyors
at the start of the day. Each surveyors will aim to survey 12 — 15 households per day (i.e. 4 — 5
waypoints per day). When the team arrives in the camp/site at the assigned location, the team
members should first meet with the area leader (block/section leader) to inform her or him that the data
collection will start. After this formality, the surveyors will proceed to finding the first waypoint and
interviewing the first three households. Upon arriving at the household, the surveyors will knock on the
door and introduce themselves and the purpose of the visit. The surveyor will request for the
appropriate respondent or household member. That will generally be the head of household, or an
adult family member who can provide WASH information on his or her behalf. Individuals that are
around but that are not directly participating in the survey should be kindly asked to leave, for
enhanced privacy of the respondent.

If the appropriate person is available, the surveyors should first explain why this particular
household was randomly selected and assure the household that information will be kept private and
anonymous. The surveyors should then explain the study procedures and ask the potential participant

12



Rapid WASH Assessments in Emergency Settings March , 2019

if he or she is willing to provide informed verbal consent for participating in the survey. If the person
agrees to participate, then data collection can begin using the data collection tool. If the person
refuses to participate, record the refusal, close the form and move on. The informed consent process
should follow the protcol approved in country.

If the appropriate person is not available, the surveyors should ask if it is possible to arrange a
return visit. If the person does not agree to a return visit, record the refusal, close the form, and move
on. If the appropriate person is not available at the particular moment (e.g. very busy) or no one is
home, the household should be revisited later. Each eligible household shall be visited at least two
times (each subsequent call at least two hours apart). If there is no success after two visits, that
household will be recorded as non-responding and the next closest household will be surveyed to
replace the non-responding household. If a household is reported as being abandoned (neighbors
report that no one has lived there for more than a month or inhabitants have been repatriated), then no
subsequent visits are needed and the next closest household will be surveyed in replacement of the
abandoned household.

5 ANALYZING AND REPORTING THE RESULTS

The analysis of data from the RLC survey rapid assessments is different from the analysis of data
from other surveying methods (such as the KAP survey), because it requires 1) adjusting the values for
the bias introduced by differences in household density, and 2) correcting the margin of error due to
the design effect caused by intracluster correlation.

5.1 Estimating household density

Estimate the household density at each waypoint based on the area of a circle defined by a radius
equal to the distance between the waypoint and the third nearest household. The calculation can be
performed as shown below, where 3.14 is the value of pi, and L is the length (e.g., in meters) between
the waypoint and the third nearest household to that waypoint.

3

Household Density = 31ax 2

5.2 Adjusting for the bias associated with household density

At the end of the survey, before the data are analyzed, the values recorded for each household
should be weighted by the relative density of households in the corresponding cluster. The weighting
factors are calculated as the estimated household density divided by the average household density in
the camp (the average of the 20 estimated household density values from each waypoint). For
example, suppose the estimated densities of households at waypoints 101 — 120 were 5, 10, or 15, as
shown in Table 3. In this example, the households near the less densely-populated waypoints were
more likely to have toilets than the households in the more densely-populated waypoints. But, they are
also more likely to get chosen from a randomly-selected GPS point, so the overall average of 50% was
adjusted down to 45%, which is the average of the adjusted survey responses (note that 0.45 = 45%).

13
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5.3 Accounting for the margins of error

Table 4 summarizes the anticipated margins of error for each WASH indicator for 60 HH samples
collected using the RLC sampling method. These margins of error have been adjusted based on the
design effects observed at the 19 sites from Bangladesh, Iraqg, and Syria that were part of the pilot
study. The margins of error shown in Table 4 are also within the range of the values estimated in
simulations done previously based on data from three camps in Ethiopia (UNHCR, 2017). In the future,
design effects can be estimated from the data collected each time an RLC survey is completed.
Monitoring the design effect in future rapid assessments can be done to ensure that the
recommended margins of error are within a reasonable range, and it also may result in the decrease of
the 95% confidence intervals associated with the estimated values shown in Table 4.

Table 4. Core indicators for the rapid assessment, as well as estimated design effects, and
estimated margins of error for 60 HH samples collected using the RLC method

No. | Core WASH Indicator UNHCR Estimated Design Estimated Margin
Standard Effect (95% CI) of Error* (95% CI)
1 Average liters per day of potable water collected per >15 L/p/d 23(2.2,2.4) 15218, 87)
person at the household level
5 Percent of households with a.t least 10 liters/person S70% 12(11,13) 113% (10%, 15%)
potable water storage capacity
3 Percent of households collecting drinking water from 570% 18(1.2, 2.4) 7% (8%, 23%)
protected/treated sources
4 Percent of households reporting defecating in a toilet >60% 2.2(1.8,2.6) +18% (1%, 24%)
5 Percent of households with access to soap >70% 1.3(1.2,1.5) +13% (9%, 17%)
6 Percent of households with a designated bathing facility >70% 1.5 (1.3,1.7) +14% (9%, 18%)

* For percentage indicators, the margin of error changes depending on the estimated value, with the largest margin of error occurring at an
estimate of 50%, and smaller margins of error occurring at higher or lower estimated percentages. The values listed in this table
correspond with the estimated margins of error at the level of the UNHCR standard (60% or 70%, depending on the indicator).

The following section (Interpreting the results) contains instructions about how to apply the margins
of error to the adjusted indicator values to assess the quality of the WASH services (with respect to the
UNHCR Standards) and to make an informed decision about whether or not an intervention needed to
improve the WASH service.

5.4 Interpreting the results

As illustrated in Box 1 above, a margin of error of +18% means that if the adjusted RLC survey data
indicate that 45% of households from a camp have access to a toilet, the true underlying percentage of
households in the entire camp with access to a toilet may be as low as 27% or as high as 63%. These
lower and upper limits are known as the confidence interval (specifically, the 95% confidence interval).
RLC survey results can be reported with a color coding system based on the estimated value of each
indicator minus the margin of error, relative to the UNHCR standard. Table 5 shows examples if the
adjusted average values for percent of households reporting defecating in a toilet were 40%, 55%, or
80%.
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Table 5. Color coding system for showing results from the RLC WASH survey rapid assessment

Color When to use this color Example for Indicator 4: What it means
% of HH reporting defecating in a toilet

When the confidence Adjusted Avg. = 80% (margin of error +18%) There is 95% confidence that the
Green interval is completely above 80% — 18% = 62% population is in compliance with
the UNHCR standard 62% > 60% the UNHCR standard.
When the UNHCR standard Adjusted Avg. = 55% (margin of error £13%) The population may or may not be

is within the confidence in compliance with the UNHCR
Yellow . 55% — 18% = 37%; 55% + 18% = 73% 2 )
interval of the sample standard. Recommend to continue
. 37% <60% < 73% Y o
estimate monitoring the situation.

There is 95% confidence that the

When the confidence Adjusted Avg. = 40% (margin of error +18%) obulation is NOT in compliance
Red interval is completely below 40% +18% = 58% . F:Nith the UNHCR standzrd
the UNHCR standard 58% < 60% :

Corrective action is needed.
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Annex

Below is a brief explanation of the process for creating a georeferenced pdf of the survey area with 30
randomly generated waypoints. This pdf can then be loaded in to a handheld device which can be
used in the field to navigate to the waypoints to collect the data. This process is described further in a
document called “Steps for Generating Random Waypoints Using QGIS” which is available on
wash.unhcr.org. In addition there are explanatory videos on UNHCR’s WASH Youtube channel.

Step #1 — Load Google Maps Layer

e Web > Openlayers Plugin > Google Maps > Google Satellite

Step #2 — Zoom to the area you would like to survey

Step #3 — Create a New Shapefile Polygon

e Layer > Create Layer > New Shapefile Layer
e Select the ‘Polygon’ option and click OK...
o Save the new polygon shapefile layer as a file...

Step #4 — Draw the Polygon Points

o Select the new polygon layer in the side panel.
o Click the toggle editing button (looks like a pencil).
e Draw the polygon boundary points. Click the right mouse button to finish.

Step #5 — Adjust Transparency

e Right click on the shapefile layer in the left panel and choose properties..
e Under the ‘style’ tab, click ‘simple fill' and set the fill color to transparent.

Step #6 — Adjust Random Points

e Click Vector > Research Tools > Random Points Inside Polygons
o Setthe number of points to the sampling strategy (e,g. 30 x 2 would require 30 waypoints)

Step #7 — Change the Color of the Points and Add Number Labels

e Right click on the ‘random points’ layer in the left panel and choose properties..

e Under the ‘Style’ tab choose an appropriate color for the points.

e Under the ‘labels’ tab select ‘Show labels for this layer and then select ‘Label with’ and choose
‘ID’ from the dropdown.

Step #8 — Publish a Geo-Referenced PDF Map using Print Composer

e Zoom the map so the polygon fills the browser.

o Click Project > New Print Composer

e Give the new Map a name..

e Inthe print composer click the ‘Add New Map’ icon on the left hand side.

e Draw a rectangle on the page to insert the map..

e Save the map as a Geo-Referenced PDF by clicking ‘Print Composer’ > ‘Export as PDF’

Step #9 — Load the Avenza Maps App onto Your Smartphone

Step #10 — Copy the Geo Referenced PDF onto Your Smartphone
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Step #11 — Open Avenza Maps App and Import the Geo-Referenced PDF

o Click the large ‘PLUS’ button in the bottom right corner to import a PDF..

e Add Map > From Device Storage

e Finally open the imported map..

e The map will show your current location in relation to the 30 random sampling points.
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